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Chapter 1st – Networking 
Que:1 Fill in the blanks 
1. ______________ is a group of two or more computers that are linked in order to share resources such as printers, 

files, and other resource. 

a. Network   b. Internet   c. Wireless   d. Topology 
2. Which of the following is the smallest type of network? 

a. MAN   b. WAN    c. LAN    d. None of these 
3. _____________ is a device that allow you to connect multiple computers to a single network. 

a. Hub   b. Bus    c. Ring    d. Star 
4.  In _________ network topology, a single backbone cable is shared by all the devices. 

a. Bus   b. Tree    c. Mesh    d. Star 
5. ____________ prepares information and sends it. 

a. Protocol   b. Receiver   c. Sender   d. Hub 
Que:2 Write True/False 
1. We cannot Share hardware or Software among network devices.    False 

2. LAN covers a large geographic area.       False 

3. In full duplex, information can be transmitted in both directions.    True 

4. Protocols are set of rules by which data transmission takes place between nodes.  True 

Que:3 Write the Full Forms: 
1.  LAN  : Local Area Network 
2.  MAN  : Metropolitan Area Network 
3.  WAN  : Wide Area Network 
4.  PAN  : Personal Area Network 
5.  NIC   : Network Interface Card 
 
Que:4 Short answer type questions 
Q:1 Write the names any four Network Topologies. 

Ans: Name of Network Topologies are given below: 

a. Bus Topology 

b. Star Topology 

c. Ring Topology 

d. Mesh Topology 

e. Tree Topology 

f. Hybrid Topology 

Q:2 Define Network Interface Card (NIC). 

Ans: A Network Interface Card (NIC) is a Printed Circuit 
Board (PCB). It is installed on the motherboard inside a 
system-unit so that a computer can be connected to a 
network. It should be fitted in each client and server 
computer. There are two types of network cards:  

a. Ethernet Card 
b. Wireless Card 

Q:3 Write the names of components of Data Communication. 

Ans: Name of components of data communication are given 
below:  

a. Sender 
b. Medium 
c. Receiver 
d. Protocol 
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Q:4 Write a short note on HUB. 

Ans: A Hub is a hardware device. This device is used in computer networks. It is used in Star 

Topology to connect multiple computers in a network. The hub typically receives data at one 

port, then it duplicates this data and makes it available on all other ports. In this way, the 

hub provides data sharing facility between computers connected in a network.  

 

Q:5 What are the two types of Ring Topologies?  

Ans: In Ring topology, all computers are connected like a ring. Each node is connected with its two neighboring nodes. 
This topology is of two types: 
1. Single Ring: In this topology, computers are connected with each other using a single cable and flow of data is 

unidirectional. 

2. Dual Ring: In this topology, computers are connected with each other using a dual ring cable and flow of data is 

bidirectional. 

 
Que:5 Long Answer Type questions 
Q:1 What is Network? Explain its advantages and disadvantages. 

Ans: A network is an interconnection of two or more computers. These computers are connected with each other using 
some communication channels so that files can be exchanged, resources can be shared and communication can take 
place.  
Advantages of Networks: 

1.   Data and information can be shared easily with the help of networks. 
2.   Hardware and software can be shared using networks. 
3.   Very fast communication is possible using networks. 
4.   Files can be used and shared faster in the network. 
5.   Backup of any computer in a network can be taken easily. 

Disadvantages of Networks: 
1.   If a network fails, all the central services break-down. 
2.   It is difficult to manage network. 
3.   It is very costly to make a network. 

Q:2 Explain the various components of computer network. 

Ans: A computer network has many components. Each component is necessary for the smooth functioning of the 
network. The main components of a computer network are described as follows: 
● Computers: The main function of a network is to connect computers. There are two types of computers used in a 

network: Client Computers and Server Computers. 
● Network Interface Card (NIC): This is a computer circuit board / card. It is used to connect a computer to a network. 
● Hub / Switch: A hub is a hardware device which is used to build a network. It is used in Star Topology to 

interconnect computers in a network. 
● Router: A router is a hardware device. It is used in the field of network. This device receives data in a network, 

then inspect it and transmits the data to the same network or to some other concerned network. 
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Q:3 Write about different types of networks. 

Ans: There are many types of networks. Depending on the size of the networks, they can be divided into the following 
four types: 
1. PAN: PAN stands for Personal Area Network. This network exists around one person. Example: Connection 

between two mobiles etc. It has a radius of about 10 meters. 
2. LAN: LAN stands for Local Area Network. Such networks are created in the offices or computer labs or at homes. It 

is usually designed to share network files or hardware devices. It is limited in size to a radius of 1 mile. 
3. MAN: MAN stands for the Metropolitan Area Network. This network is spread over a large area like a city. For 

example: cable TV. Network. A MAN typically covers an area of between 5 to 50 kms. 
4. WAN: WAN stands for Wide Area Network. This network can be spread over a large geographical area such as a 

country, continent or the whole world. Internet is the best example of a WAN network. 

 
Q:4 Explain the various modes of data transmission? 

Ans: Data transmission means the flow of data or information between the sender and the receiver. Data transfer 
between sender and receiver can be done in the following three ways: 

 
● Simplex Mode: In this mode, the communication is unidirectional. Only one of 

the devices can send a signal and the other can only receive a signal. For 
example: Communication between keyboard and computer. 

● Half-Duplex Mode: In this mode, the flow of communication can be in both 

directions, but only one device is capable of communicating at a time. For 

example: In a walkie-talkie, sender speaks on one side and the receiver on the 

other side listens and then after a pause, another speaks and the first person 

listens. 

● Full Duplex Mode: Even in full duplex mode, the flow of communication is in 

both directions, but communication is possible in both directions at the same time. This is the fastest mode of 

communication between devices. For example: Communication between two people using mobile phones. 
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Chapter 2nd  
Internet Applications 

Que:1 Multiple Choice Questions 
1. 'Gmail' is a free email service provided by_________.  

a. Yahoo   b. Google   c. Rediff mail    d. Hotmail 
2. A ________ is a type of test used in computing to determine whether or not the user is human.  

a. CAPTCHA  b. DERTSA   c. HEPTCHA   d. NEPHCA 
3. ______is a type of malware designed to provide unauthorized, remote access to a user’s computer. 

a. Spyware   b. Trojan   c. Malware   d. Horse 
4. _______ is a computer program that replicates itself into other computer programs.  

a. Spyware   b. Virus    c. Phishing    d. Malware 
5. _______ is an Indian digitization online service provided by the Ministry of Electronics and Information Technology 

(MeitY), Government of India under its Digital India initiative. 
a. DigiLocker  b. DigiProgram    c. DigiHacker   d. DigiBanker 

Que:2 Write True/False 
1. Spyware is an e-mail fraud method in which the wrongdoer sends out legitimate-looking email in an attempt to 

gather personal and financial information from recipients.      False 
2. Google Drive does not allow us to store and share files online.     False 
3. The best way to deal with the threat of a computer virus is to use antivirus software.  True 
4. The Web threat is any threat that uses the World Wide Web to facilitate cybercrime.  True 
5. Google Meet is a video conferencing service by Google.      True 

 

Que:3 Short Questions Answer 
Q:1 Define E-mail. 
Ans: Email stands for Electronic Mail. It is one of the most commonly used features over the Internet. It allows us to 
send and receive electronic messages anywhere in the world. To send and receive messages, we need an email address. 
Email address always includes @ symbol. For example: inbox.kansal@gmail.com is an email address. Gmail, Yahoo Mail, 
Rediff Mail, Hotmail are some of the popular web-mail services. 
Q:2 Give the names of any four Google apps? 
Ans: Google Apps is a suite of Web-based applications from Google:

● Gmail 
● Google Calendar 

● Google Maps 
● Google Docs 

● Google Photos 
● Google Lens

Q:3 Define Cyber Ethics? 
Ans: Cyber Ethics is the conduct of acceptable usage of online resources by a user. Cyber ethics refers to a set of moral 
rules or a code of behavior on the internet. It is to be ensured that users understand their responsibilities for conducting 
themselves online.  
Q:4 What is DigiLocker? 
Ans: DigiLocker is an Indian digitization online service. This service is provided by the Ministry of 
Electronics and Information Technology (MeitY). DigiLocker provides an account in cloud to every 
Aadhaar holder. It provides access to authentic certificates, such as: driving license, vehicle registration 
(RC), DMCs. These certificates are provided in digital format by the original issuers of these certificates. 
Digilocker provides 1GB storage space to each account holder to store documents.  
Q:5 What is Cloud Printing? 
Ans: Cloud printing is one of the latest online printing techniques to print documents. It enables users to print 
documents on any device associated with the cloud (network). Using this technique, we can connect our printer with 
the cloud network and later we can take printout of a document from anywhere at this printer. 

 

https://en.wikipedia.org/wiki/Digitization
https://en.wikipedia.org/wiki/Online_service
https://en.wikipedia.org/wiki/Ministry_of_Electronics_and_Information_Technology
https://en.wikipedia.org/wiki/Ministry_of_Electronics_and_Information_Technology
https://en.wikipedia.org/wiki/Government_of_India
https://en.wikipedia.org/wiki/Digital_India
https://en.wikipedia.org/wiki/World_Wide_Web
https://en.wikipedia.org/wiki/Cybercrime
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Que:4 Long Questions Answers? 
Q:1 What are Google Apps? Explain any two Google Apps. 

Ans: A set of web-based applications provided by Google are called Google Apps. We must have a Google account to 
use these apps. Gmail, Calendar, Maps, and Docs etc. are some of important google apps: 

1. Gmail: This Google app is used to send and receive emails. Using this app, we can send a message from 
mobile or computer to any person.  

2. Google Drive: This Google app allows us to store and share files online. Google provides 15 GB 
storage space to every Google account for storing data. 

Q:2 What is Google Drive? Write various benefits of Google Drive. 

Ans: Google Drive is a service offered by Google. This Google app allows us to store and share files online. 
Google provides 15 GB storage space to every Google account for storing data. We must have a Google account to use 
this app. 
Benefits of Google Drive: 

1. We can store our data at the online drive 
2. We can share files stored on Google drive with other persons 
3. We can view our files stored on the Google drive from anywhere 
4. Google drive provides a built-in search engine to find files easily. 
5. We can open many types of files (docx, xlsx, psd, jpg etc.) on the Google drive. 
6. All these facilities are provided free of cost by Google. 

Q:3 Write about various methods of Internet Security. 
Ans: Internet Security is a branch of Computer Security. It protects our computer from various internet threats. 
Following are some of the common methods used for Internet Security:  
● Anti-virus: Antivirus software helps us to protect our computer system from viruses. Antivirus software scans our 

online activity to make sure we are not downloading infected files. Norton, Kaspersky, Avira, Avast, Mcafee etc 
are the examples of commonly used anti-viruses. 

● Anti-Spyware: Anti-spyware software helps us to detect and remove unwanted spyware programs.  
● Prevention from Trojan Horse: We should never download or install software from untrusted sources. Never open 

an attachment or run a program received via email from untrusted sources. Make sure a Trojan antivirus is 
installed on our computer. 

● Prevention from Phishing Scam: Don’t follow the link received through SMS or emails, and login only from the 
official website. 

Q:4 What is Cyber Crime? Write various preventive measures against Cyber Crimes. 
Ans: Cybercrime is a crime that involves a computer and a network. Cyber Crimes can involve criminal activities that 
are traditional in nature, such as theft, fraud, forgery, defamation and mischief. 
Preventive measures against Cyber Crime: 

1. The user must use a full internet security suite. 
2. The user must use strong passwords for various online websites. 
3. Keep your software updated. 
4. Keep your personal and private information locked down.  
5. Keep yourself up to date on major security breaches. 
6. If you believe that you’ve become a victim of cybercrime, you need to alert the local police.  
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Chapter 3rd - Microsoft Excel (Part-1) 
Que:1 Fill in the blanks: 
1.  A workbook is a collection of the____________. 
 A. Cell  B.  Row  C. Column  D. Worksheets 
2. A cell is an intersection of a ______and a________.  
 A.  Row, Column  B. Row, Cell Address C.  Column, Formula Bar  D. None of these 
3.  Fill handle in MS Excel can be used for ___________. 
 A. Copying the contents of a Cell  B. Entering Number Series  C. Entering Custom Series D. All of the above. 
4. The Extension of MS Excel file is_______________.  
 A.  .docx/.doc B. .xlsx/.xls C.  .pptx/.ppt D. .txt 
5. Which one of the following is not a view of MS Excel? 
 A.  Page Layout B. Page Break Preview C.  Normal D. None of these 
Que:2 Write the Shortcut for following tasks: 
1. To Open an existing file in MS Excel  : Ctrl + O 
2. To Save a file in MS Excel    : Ctrl + S 
3. To Create a new file in MS Excel   : Ctrl + N 
4. To Fill Down in MS Excel    : Ctrl + D 
5. To Fill Right in MS Excel    : Ctrl + R 
6. To Copy contents in MS Excel   : Ctrl + C 
7. To Paste contents in MS Excel   : Ctrl + V 

Que:3 Write True or False: 
1. Address of Active Cell always displays in Name Box. 
2. All Columns of MS Excel are represented by numbers starting with 1. 
3. Cell containing formula displays the result of the formula, whereas the formula itself displayed in Formula Bar. 
4. MS Excel is a widely used word Processor. 
5. We can insert Number Series in MS Excel using Fill Handle. 

Ans:  1. True   2. False   3. True   4. False   5. True 
Que:4 Short Answer Type Questions: 
Q:1 Define MS Excel. 
Ans: Microsoft Excel is a spreadsheet program developed by Microsoft. It is part of MS Office Suite.  We can use it to 
organize our data into rows and columns and to perform mathematical calculations. We can also represent our data in 
the graphical way in Excel using charts and graphs. Files created in Excel are called Workbooks and they are saved with 
extension .xls or .xlsx 

 
Q:2 What are the uses of MS Excel? 
Ans: Following are some of the common uses of MS Excel: 

1) Excel can be used for mathematical calculations. 
2) Data can be represented in a graphical form using Charts. 
3) We can also prepare school Timetable. 
4) Salaries of employees can be calculated. 
5) Results of students can also be prepared in Excel. 
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Q:3 Explain Ribbon in MS Excel. 
Ans: Microsoft Excel ribbon is the panel of tabs and icons at the top of the Excel window. Excel ribbon contains almost 
all commands and features that we use during working in Excel. All these commands are organized into different tabs 
based on their functionality. Tab commands are logically subdivided into Groups. There are seven tabs in Excel 
ribbon: Home, Insert, Page Layout, Formulas, Data, Review, and View. 

 
Q:4 What is Name Box? 
Ans: Name Box is a part of formula bar in Excel. It appears at the left side of the formula bar. It is an input box. Normally, 
it shows the address of active cell. For example, if we have selected the cell B3, this name box will show the active cell 
address as B3. We can also input the cell address in the Name Box to navigate quickly in a worksheet. 

  
Q:5 Explain Rows and Columns in MS Excel. 
Ans: Rows and Columns are the important part of a worksheet in Excel. These are explained below: 

• Row: Rows are the horizontal lines of cells in the worksheet. Each row is identified by row number. Rows are named 
as 1,2,3,4, . . . . . . . so on. There are total 1048576 rows in the Excel 2010 worksheet.  

• Column: Columns are the vertical lines of cells in the worksheet. Each column is identified by column header. 
Columns are named as A, B, C, D, . . . . . , AA, AB, . . .  so on. XFD is the name of last column in Excel 2010. There are 
total 16384 columns in Excel 2010.  

Que:5 Long Answer Type Questions: 
Q:1 What are the Basic Operations for MS Excel worksheet? 
Ans: Some of the basic operations to be applied on Worksheets are given bellow: 

• Inserting New Worksheet: BY default, 3 sheets are available in Excel 2010. We can insert a New worksheet easily 
by pressing shortcut key Shift + F11. 

• Renaming Worksheet: We can also rename the worksheets in Excel. To rename a sheet, Right Click on Sheet Leaf 
→ click on the ‘Rename’ option. 

• Removing Worksheet: We can also remove a worksheet when it is no longer required. To remove a sheet, Right 
Click on Sheet Leaf → Click on ‘Delete’ option. 

• Copying a Worksheet: We can also copy an existing worksheet. To copy a sheet, Right Click on Sheet Leaf that we 
want to copy → Click on ‘Move or Copy’ option. 

Q:2 Explain the Features of MS Excel. 
Ans: Following are some the important features of Microsoft Excel: 
● Easy Data Analysis: MS Excel provides very advanced tools like Sorting, Filtering, etc. to analyze the data easily.  
● Conditional Formatting: We can format our data based on different rules and conditions.  
● Data Validations: It enables us to validate data based on certain criteria.  
● Easy to Store and Find Data: We can store and find data easily in the worksheets. 
● Functions and Formulas: Excel provides various types of functions and formulas to perform calculations. 
● Data Protection: Sheets of MS Excel can be protected using passwords.  

Q:3 Write the differences between Workbook and Worksheet. 
Ans: Following are the difference between worksheet and workbooks: 

Worksheet Workbooks 

1. The Worksheet is a single-page spreadsheet.  1. A workbook is just a file of Excel. 

2. A Worksheet consists of Rows and Columns. 2. A Workbook consists of Worksheets. 

3. Worksheets can be added in a workbook 3. Workbook cannot be added within the worksheet. 

4. No worksheet can be saved without workbook. 4. Workbooks are saved individually with the 
extension .xlsx 
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Chapter 4th 
Microsoft Excel (Part-II) 

Que:1 Fill in the blanks: 
1.  By default, each new workbook in MS Excel 2010 contains ______ number of worksheets. 
 A. 5    B.  2     C. 255    D. 3 
2.  Which objects can be added in a worksheet?  
 A.  Cells    B. Charts   C.  Rows    D. All of these 
3.  Which are the valid types of Charts in MS Excel. 
 A. Bar, Column, Pie, Line  B. Area, Doughnut, Scatter  C. Surface, Radar, Bar  D. All of the above 
4.  Which function is used to find minimum number from the given range.  
 A.  Average    B. Min    C.  Max     D. Rank 
5.  _____is a powerful tool of MS Excel used to have graphical representation of our data in MS Excel.  
 A.  Data Validation  B. Conditional Formatting C.  Charts    D. None of these 
Que:2 Write True or False: 
1. New cell, row or column can be added by using Ctrl and + keys from keyboard.   True 
2. SUM and MIN are examples of Chart Types in MS Excel.      False 
3. Cell Borders, change cell width or height, Merge cells, Align Texts, Change Orientation of text, Wrap Text etc. are 

examples of cell styles.          True 
4. Conditional Formatting is a tool in MS Excel that allows applying formats to a cell or range of cells depending on 

the value.            True 
5. Formatting options effectively represents the information from facts of data.   True 

 

Que:3 Short Answer type Questions: 
Q:1 What do you mean by Formatting? 
Ans: Formatting refers to change in the appearance of contents. We can format the data in many ways. Formatting 
makes our data more readable. There are many tools in MS Excel which can be used to format text and cells. It includes: 
changing the color and style of text and cells, aligning texts, formatting numbers and dates etc. 
Q:2 Which type of formatting can be used as Cell Styles? 
Ans: There are several options for changing the styles of cells, some are given below: 

1. Cell Borders 
2. Aligning Text 
3. Changing Orientation of Text 

4. Wrapping Text 
5. Applying Number Formats 

Q:3 What do you mean by Merging Cells? 
Ans: Merging Cells means combining two or more adjacent cells to make them a single cell. We can merge any number 
of cells in Excel. To merge selected adjacent cells, we can use ‘Merge and Center’ option available in the Home tab of 
Excel. 

 
Q:4 Define alignment and its types. 
Ans: Alignment is a formatting style for cells. It is used to describe how text is placed in the cell. Text of cell can be 
aligned horizontally and vertically. Alignment options are available in the Home tab of Excel. For Horizontal Alignment 
of contents in a cell, we can Left align, Center align and Right align options, while For Vertical Alignment, we can use 
Top align, Middle align and Bottom align options in Excel. 
 
Q:5 What are Charts? 
Ans: Chart is an important feature of Excel. It is used to represent data in the 
graphical form. Charts are useful in better understanding of information. Chart is 
the best way to compare values or to show trends in the data. We can create 
many types of charts in Excel, such as: Pie Chart, Column chart, Line Chart, Bar 
Chart, Area Chart etc.  
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Que:4 Long Answer type Questions: 
Q:1 What is conditional Formatting? Explain its different options. 
Ans: Conditional Formatting is a tool in MS Excel. It is used to apply formatting on cells based on 
some condition. Formatting on cells will be applied only when cell data matches with the criteria 
defined in conditional formatting. Conditional formatting option is available in the Home tab. Some 
of the common options for conditional formatting are given below: 

• Highlight Cell Rules: like Greater Than, Less Than, Between, Equal to, Duplicate Values etc. 

• Top/Bottom Rules: like Top 10 Items, Bottom 10 Items, Above average etc. 

• New Rule: We can create new Rules also for conditional Formatting using this option. 

• Clear Rules: We can clear the already defined formatting rules using this option. 

• Manage Rules: We can edit the already defined formatting rules using this option. 
 
Q:2 What are charts? Give the name of any five types of charts. 
Ans: Chart is an important feature of Excel. It is used to represent data in 
the graphical form. Charts are useful in better understanding of 
information. Chart is the best way to compare values or to show trends in 
the data. We can create many types of charts in Excel, such as:  

1. Pie Chart 
2. Column chart 
3. Line Chart 
4. Bar Chart 
5. Area Chart etc 

 
Q:3 Explain any three objects which can be added in MS Excel worksheet. 
Ans: Many types of objects can be added in the Excel worksheet. Some of them are explained below: 

1. Inserting Rows: Rows are the horizontal lines of cells in the worksheet.  We can insert new rows easily in the 
sheet. To insert a new Row, Click on Insert → “Insert sheet rows” in the Home tab ribbon. 

2. Inserting Columns: Columns are the vertical lines of cells in the worksheet. We can insert new columns easily in 
the sheet. To insert a new column, Click on Insert → “Insert sheet rows” from Home tab ribbon. 

3. Inserting Charts: Chart is used to represent data in the graphical form. Different types of charts can be created 
easily in Excel, such as: Bar, Column, Pie, Line, Area, Doughnut, Scatter, Surface chart etc. Insert tab can be used 
to create charts in Excel. 
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Chapter 5th – Microsoft Excel (Part-III) 
Que:1 Fill in the blanks: 
1.  Each function or formula must start with _______ symbol in MS Excel. 
 A. +    B.  =     C. &   D. ^ 
2. Which function of MS Excel can be used to find minimum no from given range?  
 A.  Minimum  B. Mid    C.  Min    D. None of these 
3.  Ampersand (&) symbol is an alternate of _____ function in MS Excel.  
 A. Sum    B. And     C. Concatenate  D. Power 
4. Which data tool can be used to have only distinct values in a particular column? 
 A.  Data Validation  B. Text to Columns  C.  Formula   D. Remove duplicates 
5. Which one is an example of Arithmetic Operator?  
 A.  +    B. %    C.  ^   D. All of these 
Que:2 Write True or False: 
1. We cannot count blank cells in MS Excel.       False 

2. Formula is an expression of operators and operands to perform calculations.  True 

3. SUM function can be used to perform addition of values in a particular range.  True 

4. Text to columns option can be used to split our contents in multiple cells.   True 

5. NOW function returns current date and time in MS Excel.     True    

Que:3 Short Answer Type Questions: 
Q:1 Write arithmetic operators being used in MS Excel. 
Ans: Arithmetic operators are used to perform basic mathematical operations. The list of these operators is as under: 

Symbol Description Example Result 

+ Used for Addition =3+3 6 

- Used for Subtraction =3–3 0 

* Used for Multiplication =3*3 9 

/ Used for Division =3/3 1 

% Percent =30% 0.3 

^ Used for Exponentiation =3^3 27 
 

Q:2 What do you mean by Data validation? 
Ans: Data Validation is one of the most important tools of Excel. Using this 
tool, we can define the rules for data to be allowed in the cell. If entered 
data in the cell does not follow the specified rules, it will display an Error 
Message. This tool is available in the Data Tab. 
 

Q:3 Give the name of any three mathematical functions. 
Ans: Following are the commonly used mathematical functions: 

• SUM( ) Function 

• COUNT( ) Function 

• AVERAGE( ) Function 

• MIN( ) Function 

• MAX( ) Function 

Q:4 What is Sorting in MS Excel? 
Ans: Arranging data in a sequence is called Sorting.  Data can be arranged in ascending or 
descending order. To sort data in excel sheets, Home or Data tabs can be used. To arrange data 
in Ascending Order, we use option and for Descending Order we use option. 
 
Q:5 Define formula. 
Ans: A formula is an expression that operates on values. These 
expressions may include constant values, cell addresses and operators. In 
Excel, formulas are used to perform calculations on numerical data. Each 
formula begins with equals to (=) sign. Standard operators (+, -, *, /, ^ 
etc.) can be used in formulas to perform different types of calculations.  
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Q:6 Give the name of conditional functions used in MS Excel. 
Ans: Commonly used conditional functions used in MS Excel are given below: 

• IF( ) Function 

• SUMIF( ) Function 

• COUNTIF( ) Function 
Que:4 Long Answer Type Questions: 
Q:1 What is Cell Referencing? Explain its types. 
Ans: Cell reference refers to the cell address. Cell references are used in formulas and functions to perform calculations 
on cell data. For example: =A1+A2. Here A1 and A2 are the cell references.  
Types of Cell References: There are three different types of cell references in Excel:  

• Relative Reference: This is a default referencing in MS Excel. When formulas with relative reference are copied 
to other location, cell references change according to the change in the position of rows and columns.  For 
Example: =A2+B2 

• Absolute Reference: When formulas with absolute reference are copied to other location, cell references do 
not change according to the change in the position of rows and columns. Both Rows and Columns remains fixed 
while copying formulas. $ symbol is used with row and column address of a cell to specify absolute reference. 
For Example: =$A$2+$B$2 

• Mixed Reference: This cell referencing is a mixture of both Absolute and Relative references. Only either Row 
or Column remains fixed while copying formulas. For Example: =A2+ B$2 

 
Q:2 Define any three String Functions. 
Ans: String functions are used on text data only. Commonly used String Functions are explained below: 

1. LEN Function: This function is known as Length function. We can find the no of characters including spaces and 
symbols within a string using this function.  
For example:  =Len(“Hello Students”)   It will show 14 as length of string. 

2. LOWER Function: This function is used to convert the string into lower case.  
For Example:  =Lower(“HELLO”)   It will show hello. 

3. UPPER Function:  This function is used to convert the string into upper case.  
For Example:  =Upper(“Hello”)   It will show HELLO. 

Q:3 What is Function? Explain any two mathematical functions with suitable example. 
Ans: Functions are the predefined formulas. These formulas can be used for calculations in Excel sheets. Each function 
begins with the symbol = in Excel. Following are two commonly used mathematical function: 

1. MIN Function: This function is used to get smallest/minimum number from the given range of cells.  
For Example: 

 
2. MAX Function: This function is used to get largest/maximum number from the given range of cells. 

For Example: 
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Chapter 6th – Microsoft Excel (Part-IV) 
Que:1 Fill in the blanks: 
1.  Which option belongs to Page Layout Tab? 

A. Page Orientation  B.  Paper Size   C. Print Area  D. All of these 
2. Which one is not a view in MS Excel?  

A.  Formula View  B. Normal View   C.  Page Layout View D. Page Break Preview 
3.  __________ is the empty space between the worksheet data and the edges of the printed page.  

A. Paper Size   B. Print Area    C. Margin  D. Print Preview 
4. ________ appears on the top of each page in print preview and printed sheets. 

A.  Footer   B. Header   C.  Bottom Margin D. None of These 
5. We can lock our cells from being accidently changed with the help of ___ Option. 

A.  Save As   B. Save    C.  Print Area  D. Protect Sheet 
Que:2 Write True or False: 
1. Workbook cannot be protected in MS Excel.       False 
2. We cannot remove Page Break once inserted.      False 
3. Page Orientations are of two types: Portrait and Landscape.     True 
4. Margins can be on top, bottom, left, right header and footer of a page.   True 
5. We can use Print Area option to print a specific part of a Worksheet.   True 
Que:3 Short Answer Type Questions: 
Q:1 What do you mean by Margin? 
Ans: A margin is the space between the main content of a page and its edges. We can set margin in all 
four directions of a page, i.e. Top Margin, Bottom Margin, Left Margin and Right Margin. The margin 
helps to define where a line of text begins and ends. Commonly, document’s margin-size is set to one 
inch. Margin size can also be adjusted as per our requirement.  
Q:2 Write a short note on Page Orientation. 
Ans: Page orientation refers to the direction of document in which it is displayed or printed. We can use our page either 
in horizontal or vertical direction. We can change the orientation of document using Page Layout tab. Therefore, there 
are two basic types of page orientation:  

• Portrait Orientation: This orientation defines the document in vertical direction. 

   
• Landscape Orientation:  This orientation defines the document in horizontal direction. 

Q:3 What do you mean by Scaling? 
Ans: Scaling is the process of compressing or expending the contents of a page so that it can be adjusted on a specific 
page/pages. This option is very useful when we have to work on a large worksheet. Using this option, we can adjust all 
the contents of a worksheet on a single page. Similarly, a small content can also be expanded over multiple pages. 
Scaling options are available on the Page Layout tab in Excel. 

 
Q:4 Give names of views in MS Excel. 
Ans: There are five different types of views available in MS excel.  

1. Normal View (Default View) 
2. Page Layout View 
3. Page Break Preview 
4. Custom Views 
5. Full Screen View 
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Q:5 What is the use of Page Break? 
Ans: Page break is an important option of Excel. It is a special marker that 

will end the current page and start a new one. This is very useful option if 
we want our contents to be printed among different pages.   This option 
is available on the Page Layout Tab. Page break is always inserted at top 
left corner of active cell.  
Que:4 Long Answer Type Questions: 
Q:1 What do you mean by Page Layout? Explain three Page Layout options. 
Ans: Page layout refers to the arrangement of text, images, and other objects on a page. In Excel, Page Layout options 
are mainly concerned with printing of our worksheet. Page Layout tab provides commands to change the layout of our 
page: 

 
• Orientation: Page orientation refers to the direction of document in which it is displayed or printed. We can use our 

page either in horizontal (Landscape) or vertical (Portrait) direction. 

• Margin: A margin is the space between the main content of a page and its edges. We can set margin in all four 
directions of a page, i.e. Top Margin, Bottom Margin, Left Margin and Right Margin.  

• Scaling:  Scaling is the process of compressing or expending the contents of a page so that it can be adjusted on a 
specific page/pages. This option is very useful when we have to work on a large worksheet. 

 
Q:2 Explain any two Views of MS Excel in detail. 
Ans: There are five views available in MS Excel. Commonly used views are explained below: 

• Normal View: This is a default view of MS Excel. When we open MS Excel, our file automatically displayed in Normal 
View. This view is the easiest view to use for managing data, creating formulas and formatting rows and columns. 
We can change our view to Normal view using View Tab. 

 
• Page Break Preview: This view of MS Excel is mainly concerned with Printing of our worksheet. This View is a very 

powerful print preview. It allows us to manually move page breaks and reorganize a worksheet into pages for 
printing. We can change our view to Page Break Preview using View Tab. 

 
Q:3 What is Header and Footer? How will you apply Header and Footer in Excel? 
Ans: Headers and footers are the important elements of a worksheet. Headers 
and footers are lines of text that print at the top (header) and bottom (footer) 
of each page. This option is very useful to add any important information like 
page number, file name or any other custom message. Steps to apply header and 
footer are given below: 
1. Click on the Page Layout tab. 
2. Open Page Setup dialog box by clicking the launcher icon in the Page Setup 

group.  
3. In this dialog box, Click on Header/Footer Tab. 
4. Set the Header and Footer details using appropriate options.  
5. Click on OK button. 
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Chapter 7th  
E Governance 

Que:1 Multiple Choice Questions: 
1. Which is/are the levels of E-Governance? 
 a. National Level  b. State Level   c. Local Level  d. All of the above 
2.  Which of the following is not a pillar of E-Governance 
 a. Capital     b. Knowledge   c. Delay in Work d. Connectivity 
3. E-Governance Services can be shared between Government and _________ 
 a. Citizens     b. Government   c. Businessman  d. All of these 
4.  ____________ model of e-governance refers to the government services which are shared by citizens. 
 a. G2B   b. G2E    c. G2G   d. G2C 
5.  E-governance services at National level are provided by __________Government of India. 
 a. Local     b. State    c. National  d. All of these 
 
Que:2 Write the Full Forms of the Following: 
1. G2C   Government to Citizen 
2. G2G   Government to Government  
3. G2E   Government to Employee 
4. G2B   Government to Businessmen 
5. IRCTC   Indian Railway Catering and Tourism Cooperation 

 
Que:3 Short Answer Type Questions: 
Q:1 Define Good Governance. 
Ans: "Governance" means the process of decision-making and their implementation. Good Governance is the processes 
of making and implementing decisions in a preferred way. It’s not about making ‘correct’ decisions, but about the best 
possible process for making and implementing those decisions. 
 
Q:2 What are the different levels of E-Governance? 
Ans: Following are the different levels of E-Governance:  

• National Level 

• State Level 

• Local Level (Urban and Rural) 
 
Q:3 Write the name of Four Pillars of E-Governance.  
Ans: Following are the four pillars of E-Governance: 

1. Connectivity  
2. Knowledge 

3. Data Content 
4. Capital 

 
Q:4 Differentiate Governance Vs. E-Governance. 
Ans: We can differentiate governance and e-governance as given in following table. 

GOVERNANCE E-GOVERNANCE 

• Governance refers to the process of decision-
making and their implementation without 
the use of ICT.  

• It uses one-way communication protocol. 

• E-Governance refers to the use of ICT to improve 
the range and quality of information and 
services delivered to the public. 

• It uses two-way communication protocol. 

 
Q:5 Write about the G2C model of E-Governance. 
Ans: G2C stands for Govt to Citizen. This model of E-Governance refers to those government services which are shared 
by the citizens. In this model, citizens visit the official web-portals of government to access the various types of services. 
This model strengthens the bond between government and its citizen. Payment of online bills, Online passport 
registration etc. are the examples of services included in this model. 
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Que:4 Long Answer Type Questions:  
Q:1 Write the main characteristics of Good Governance. 
Ans: Following are some of the important characteristics of a Good Governance: 

1. Good governance is answerable to the community for its decisions. 
2. Good governance is transparent. 
3. Good governance follows the rule of law. 
4. Good governance is responsive which means that government always tries to serve the needs of the entire 

community timely and appropriately. 
5. Good governance is effective and efficient in implementing decisions that make the best use of the available 

resources. 
6. Good governance is participatory. Anyone has the opportunity to participate in the process of decision making. 

 

Q:2 What is E-Governance? Explain the four models of E-Governance.  
Ans: E-Governance stands for Electronic Governance. It refers to the use of ICT to improve the range and quality of 
information and services delivered to the public. E-Governance has made the working of government more transparent. 
Models of E-Governance: 

1. Government to Citizens (G2C): This model refers to the government services which are shared by citizens. For 
Example: Payment of online bills, Online passport registration etc.  

2. Government to Business (G2B): This model refers to the government services which are shared by businessmen. 
For Example: Collection of taxes, Payment of bills etc. 

3. Government to Employees (G2E): This model refers to the government services which are shared by its 
employees. For Examples: Employees can access any kind of rule-regulation, Employees can check their payment 
and records etc.  

4. Government to Government (G2G): This model refers to the government services which are shared between the 
governments. For Example: Sharing of information between police department of various state etc.  

 

Q:3 Make a list of various Services provided at National level of E-Governance. 
Ans: Some of the important E-governance services at national level are given below: 

1. Banking Services 
2. Aadhar services 
3. Passport Services 
4. Immigration & Visa Services 
5. Filing of Income Tax Returns 
6. Payment of various types of Taxes 
7. Central Excise and Custom Services 
8. Digital Land Management Systems 
9. Voter card services 
10. PAN Card services 

IRCTC, UMANG, DigiLocker, e-Pramaan etc. are the examples of various projects that provides services at National level. 
 

Q:4 What are the E-Governance Services in the Urban Areas? 
Ans: Following are the E-Governance Services that are provided in Urban Areas:  

1. House Tax Assessment  
2. Billing and Collection  
3. Maintaining records of Land & property 
4. Issue of Passport Verification Certificate  
5. Issue of Birth or Death Certificates 
6. Registration of Properties 
7. Provide services such as old age pension, widow pension, freedom fighter pension etc.  
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Chapter 8th  
Database Management System 

Que:1 Fill in the blanks: 
1.  ______________ is a raw and unorganized fact that requires processing to make it meaningful. 
 a. Data   b. Information   c. Database   d. DBMS 
2.  A Record is also known as a _______________. 
 a. Column   b. Attribute   c. Field    d. Tuple 
3.  A person who manages and controls the overall DBMS is called a__________ 
 a. DBA   b. End User   c. Database Designer  d. Programmer 
4.  DBMS is a software layer that provides an interface between _________ and the _______________. 
 a. Data, Information  b. DBA, End User  c. User, Database  d. Data, Database  
5.  ___________________ refer to general rules and instructions that help to design the database and to use a database 

management system 
 a. Information  b. Procedures   c. Application Programs d. System Programs  
 
Que:2 Write the Full Forms: 

1. DBMS  Database Management System 
2. DBA  Database Administrator 
3. SQL  Structured Query Language 

 
Que:3 Short Answer Type Questions 
Q:1 What is record? 
Ans: A record is an important element of a database. It a collection of 
named data-items. It represents a complete unit of information in the 
table. A Record is also known as a Tuple. Following table shows the 
example of four student records. 
 

Q:2 Define Database. 
Ans: A database can be defined as the organized collection of interrelated data. Databases are used to store the vast 
amount of data in various organizations. A database provides organized structure to store data electronically. Generally, 
data in the database is organized into rows, columns, and tables. A database may have one or more tables. 
 

Q:3 Write the name of different types of users of database. 
Ans: Following are the different types of users of database: 

• Application Programmers 

• Database Administrators 

• End-Users 
 

Q:4 What do you know about DBMS? 
Ans: DBMS stands for Database Management System. To overcome all drawbacks 
of file processing system, a new system called Database Management System 
(DBMS) was developed. DBMS is a system software. It provides us the facility to 
create, retrieve, update and manage data of the database. In simple terms, we can 
say that DBMS is a software layer that provides an interface between user and the 
database. 
 

Q:5 Write the name of various components of Database environment. 
Ans: Following are the various components of Database Environment: 

a. Software (Operating System, DBMS) 
b. Hardware 
c. Procedures 
d. Data 
e. Users 
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Que:4 Long Answer Type Questions: 
Q:1 Write the differences between Data and Information. 
Ans: Following are the major differences between Data and Information: 

Data Information 

1. Data is raw and unorganized fact that requires 
processing to make it meaningful 

1. Information is processed data that does not require 
any processing to make is meaningful 

2. Data does not have any specific purpose 2. Information carries a meaning 

3. Data alone has no significance 3. Information is significant by itself 

4. Data is measured in bits and bytes 4. Information is measured in meaningful units like 
time, quantity, etc. 

Q:2 Explain the various components of DBMS Environment. 
Ans: Following are the major components of DBMS environment: 

• Software: Software refers to the collection of programs used with in the 
database environment. It includes the Operating System, DBMS 
Software, Application Programs and Utilities. 

• Hardware: It includes all the physical devices of database system. For 
Example: Computer System, Main Memory, Secondary Storage etc. 

• Procedures: It refers to general rules and instructions that help us to use 
a database system.  

• Data: It is the most important component of the database. The main task 
of DBMS is to process the data.  

• Users: The users are the people who control and manage the databases. 
For Example: Application Programmers, DBA, End-Users 

Q:3 Differentiate File Processing System and DBMS. 
Ans: There are following differences between DBMS and File system: 

File Processing System DBMS 

1. File processing system manages files in a storage 
medium. 

1. DBMS is a software for managing the database. 

2. There may exist redundant data in the files. 2. There is almost no redundant data in the databases 

3. File system doesn't have a crash recovery mechanism 3. DBMS provides a crash recovery mechanism 

4. It doesn’t provide backup and recovery system. 4. It provides backup and recovery system. 

5. There is no efficient query processing in file system. 5. There is efficient query processing in the DBMS. 

6. There is less data consistency in file system. 6. There is more data consistency. 

7. It is less complex as compared to DBMS. 7. It has more complexity. 

8. File systems provide less security 8. DBMS has more security mechanisms. 

9. It is less expensive than DBMS. 9. It is more expensive. 

Q:4 What is DBMS? Explain any five advantages of DBMS. 
Ans: DBMS stands for Database Management System. To overcome all drawbacks of file processing system, a new 
system called Database Management System (DBMS) was developed. DBMS is a system software. It provides us the 
facility to create, retrieve, update and manage data of the database. In simple terms, we can say that DBMS is a software 
layer that provides an interface between user and the database. 
Advantages of DBMS: 

• There is almost no data redundancy in DBMS 

• Inconsistency in data can be controlled in DBMS 

• Data can be shared by multiple users in DBMS 

• DBMS Provides built-in Backup and Recovery system 

• Unauthorized users cannot access the database 

• Multiple users can access the same data from the database 


